Year 8

WEB SITE DESIGN

Using Dreamweaver

Before beginning this project students are required to download the
folder Student Resources Y8 Making a Website, from the All
Staff server from your teachers area (e.g. JC) and their student
read folder (e.g. JC studR), Year 8, Topic 3

Group: 8.

Name:
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The aim of this project is for you to learn how to design and create a website
P ( _ for Sha Tin College, Reviews Magazine.

=

<L "~ Your website should:

Be suitable for the intended audience

Have relevant and interesting content

Have a consistent look and feel

i . . R Show features of good design
| F Use hyperlinks to navigate from page to page
NE! ms Contain images

TASK 1

Before you create your own web pages, you need to consider what makes a good or a bad
website.

Open the document called Evaluating Internet Sites.doc on the ‘Staff Drive’ and save it to a
folder in your area called ‘Topic 3 Web Design’. (www.msc-ks3technology.wikispaces)

/B f = . . Remember to include
Look at the following two websites the web address (URL)

=T e www.tbshumorstudy.com
e www.cartoonnetwork.com

of the website that
¥ AP W you are reviewing.
~— Assess these websites and answer the questions in the document.

— 7 [~'—  From your research, list 6 key points that describe a well designed website. Print out the
8 B8 finished document and make sure that you put your name in the header or footer.
‘i
TASK 2
Open a new Word document and save it, calling it ‘Designing Remember to include the
Websites for Different Audiences’. web address (URL) of the
Find a website aimed at an adult audience and DAL AT
= one aimed at teenagers. Try to identify the N
-y~ techniques they have used to appeal to each different
-~ |-~ audience.
: ? ij Create a table in your Word document (see below) and record the different points that you
have identified.
. o< Site for Adult Audience Site for Teenage Audience

| O |l W[ N =~
| O |l W[ N =~

Print out the finished document and make sure that you put your name in the footer.
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TASK 3

Ll [ Using Notepad to create a HTML webpage. Follow the instructions step by step.

A= =

s 2 Open Notepad (Programs > Accessories)

Save the file straight away as:
-~  File name: index.htm Note ... the first page in a website is always called index.htm
Save as type: All Files (change from Text Documents)

_ P Fl A basic page

<L <html>
gk <body>
Search Engines
</body>
</html>

Save the file
Look at the result in a web browser What shows up on the page?

Changing text styles
-8 — <html>
f <body>
=  <hl1>Search Engines</h1>
</body>
</html>

By Save the file ‘% How has the text changed?
—= r Look at the result in a web browser

i

T Splitting lines

<htmlI>
<body>
<h1>Search Engines</h1>
YouTube<br>
MSN<br>
Google<br>
</body>
—E |' —  </html>

~L ' Save the file
[~ Look at the result in a web browser

— - Adding Hyperlinks

. _. _ <html>
‘ <body>
2L 7~ <hl>Search Engines</h1>

A <a href="http://www.youtube.com">YouTube</a><br>
<a href="http://www.msn.com">MSN</a><br>

<a href="http://www.google.com">Google</a><br>
</body>
</html>

Save the file
inks?
Look at the result in a web browser ﬁ What colour are the links:
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Adding a title to the page
_ s Where is the title on the page in the
: [ 0] 01T i P
R <htmlI>
74— <head>
- <title>Information on Search Engines</title>
</head>

-7 [~  <body>
. | <hl>Search Engines</h1>
~ <a href="http://www.youtube.com">YouTube</a><br>
P <a href="http://www.msn.com">MSN</a><br>
<a href="http://www.google.com">Google</a><br>
</body>
</html>

Make a note of the file size of the document “index.html” ..................... (Look in Properties)

Set background colour (Note the spelling of colour ... color)

| ] ??7?7?7?7?is the colour as a nhumber
‘ f Each colour has a code. Other colours
iE (e are:
| bf—' Set text colour FFO000 = Red
N <body text=??7???> EEEEQO = Yellow
=l . OOFFO0 = Green
N7 lalic text 800080 = Purple
g g <> </i> FFFFFF = White
ZLTC N 000000 = Black
L Iwk New paragraph
\ SR <p> </p>

New paragraph aligned to left, right or center (this aligns the text to itself ... not the
page)
< p align=?>
Some more common HTML tags
<font size="6"> change to size 6 font (you can choose any size between 1 and 7)
—E |' —  <ul> Create a bulleted list (this tag must be put in front of each item in the list)

<hr> Horizontal line

To Insert a Picture
, P <img src="www.gif">

“ '~ This tag would insert a picture with the filename www.gif
ulf _ The picture you want to enter must be in the same directory as your web page.

I"

Make a note of the file size of the document “index.htm

Look in Properties
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TASK 4

i ”ﬁ Use a word processor to create a web pages. Using Word open a new document

Type the following:

;; Search Engines
. YouTube

PN

4 F MSN

2L  Google
Highlight 'Search Engines’ and make it into a Heading (from the text formatting tools)

Highlight 'YouTube’ and from the Insert menu select Hyperlink
Type in the web page name for the site http://www.youtube.com

Repeat for the other two sites
= http://www.msn.com
( http://www.google.com

From the File menu select Save as Web Page

-~ And save as Search Engines.htm and select the file type as Web Page *htm, *html (It will
| automatically open up as an interactive page)

Open your web browser and open Search Engines.htm

e Compare and make notes about making these two similar basic web pages, using HTML code
and a word processor

LS Now return to your Word file "Search Engines.htm” and from the View menu select “HTML

s l\‘ Source”
.

=~ Compare this HTML code with the code you wrote using Note Pad

What do you notice?

Make a note of the file size of the document “Search Engines.htm” ....................... (Look in
Properties)

Think about the technical issues that affect electronic communication

Complete these tasks for Homework
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HOMEWORK TASK 2

d " This task is to be completed for homework.

A= =

7 Con

Poi

T

Add your name, class and the title ‘Homework Task 2’ and the date in the footer
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sider different methods of publishing material e.g.

Encyclopaedias

Newspapers )

Write a document entitled ‘Is the Internet more useful than traditional printed material?’

“
O

O
-
- Sots
O
o

nts to think about: )

o o

How up to date is the information?

How accurate is the information?

How many people can access the information at a given time?
Do you need any special equipment?

Are there any potential dangers with this resource?

& &



You are going to create pages for a new website for Sha Tin College called “Reviews”

_ ¢ Magazine, which will feature the extra curricular activities that many students are involved in
ﬂ‘L ~ within Sha Tin College.

To create these pages, you will be using a web publishing software called Adobe Dreamweaver
CS3 (formerly Macromedia)

TASK 5

Next you will need to load Adobe Dreamweaver CS3
The first thing you must do is manage your site, so follow the steps below carefully.

ADOBE® DREAMWEAVER® C53

Open a Recent ltem Create New Create from Samples
(= Open T ] 55 Style Sheet

T coldFusion T Framesst

0 e

T asp vBSoript

0] HSLT (Ertire page) (53 More

T css

T davascript Extend

g FTP or RDS, FTP or RDS

@ Dreamweaver Exchange »

] MewFeatures » Techrical content, code, and community,
O Resources »

(] Getting Started » m adobe Developer Connection - New

Next > Cancel Help
L] Derit show ausin

(Or on the menu bar at the top, go to Site > New Site ... )
Call the site your name followed by Reviews Magazine (e.g. MsC Reviews Magazine)

Site Definition for Reviews Magazine.

ColdFusion, ASPNET, ASF. JSF, or PHF?

e <Back Next > Cancel el

No, I do not want to use server technology

Next

Click on the yellow folder button and find where you copied the folder to
Click Open, then Select

Next

i

mote info:
Agoess: Msel ths up later,

Testing server:
Access: et ths up late,

Your site can be further coiiguied using the Advanced Tab.

Put None in the drop down box
Next
Done
Done
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TASK 6

Click on file and select New > Blank Page > click Create,
Save naming the file as “index.html”

i &

' Page Type: Layout:
p HTML <none ~
I LS ElagkcPace ; HTML template 1 column elastic, centered
\-————ﬂ/ ; Library item 1 column elastic, centered, header and
L % Blank Template i XSLT (Entire page) 1 column fixed, centered
= XSIT (Fragment) 1 column fixed, centered, header and { ——
o I ActionSeript 1 column liquid, centered P
@ Fage fiom Template | o css 1 column liquid, centered, header and 1
- 2 calumn elastic, left sidebar
ﬂ = et 2 column elastic, left sidebar, header a
-j Page from Sample o XML 2 calumn elastic, right sidebar
s . 2 column elastic, right sidebar, header
' Other o :gz i ;::;:Pt 2 column fixed, left sidshar e
(] 2 column fixed, left sidebar, header an
? ASP.NET €= 2 column fixed, right sidebar —
? ASP.NET VB 2 column fixed, right sidebar, header a
T ColdFusion 2 column hybrid, left sidebar
7 ColdFusion companent 2 column hybrid, left sidebar, header a DocType: XHTML I‘U_Tm;i
""Z J5P 2 calumn hybrid, right sidebar —
= PHP 2 calumn hybrid, right sidebar, header
o 2 column liquid, left sidebar Attach CSS file: LM
2 column liquid, left sidebar, header an
A 2 column liquid, right sidebar b

What should you create? A 4 page website showing “"Reviews” Magazine

The first page “index.html” should have the school logo and a set of buttons that link to all of
the other pages (and to itself)

There should be a page for:

CAS Week

The Concert

The OSCARS

As well as the Home Page (index.html)

Inside the images folder (Student Resources Y8 Making a Website, sc_reviews) there are
buttons for each page (2 buttons for each so you can make rollover buttons (total 8 images))
There are 3 pictures to go on each page after the Home (index) page.

Every Page must have the buttons to link to the other pages.

You will need to use at least one table on each page to position the buttons and another for
the pictures. Next to each picture you should write a sentence to say something about it (you
can make this up) eg ... “Here we see Uma Thurman at the OSCAR ceremony”

Follow the instructions carefully to creating your index page

Use tables to arrange the images and text on the page, you can create tables using the table
button you can put tables in tables or merge cells together.

-
rr

You can add colour to cells and change the cell padding —

(spaces in between) in the Properties box

i v Properties

Format | Mone v Style!None vl B I E =EEE Lk | v| D

Fant | Defaulk Font Size|NDne vi J| = iz = Target
;ﬂ cell Horz [Defaul o | W | Mo wrap [ Bg |@'lﬁ
rr
= J; Vert |Defaut v | H | | Header (] Bg _I:J'#FFFFGS Brdr Jl:|
T
cell merge cell colour
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Notes On Web Pages

tH " .~ HTML

7 Hypertext Markup language ... the code used to write web pages
4 U Tag..e.g. <body> </body>... an HTML instruction code
= UuRL

i . F_ Uniform Resource Location (or Locator) ... the address of a web page

<.~ When designing web pages ...
‘ Everything is measured in pixels (the dots that make up a screen picture)

Never use capital letters in any file names and use __ (underscore) instead of spaces

The first page must always be called index.html

Use .jpg files for photographs, .png files if you want a transparent background for a
W picture or button and .gif if you want an animated picture (can also have a
( transparent background but only limited colours)

P41 When colouring images in other software e.g. Xara, Photoshop or Flash, use web safe
= Cl colours, hexadecimal colours

{C;* Optimise pictures before putting them on web pages ... i.e. make them the right size
rud (in pixels) and the file as small as possible to make sure they load quickly before
f*:’r F you insert them into your website.

P Use tables to lay out the contents of a web page
Make sure text stands out clearly against the background of the page

Do not use too many flashing animated gifs

Golden rules when designing a website...

e Design
= e Ease of use
7 [ ~ o Copywriting
+ R o Interactivity
[ e Use of technology
> AL A e Innovation

—F- ¢ Content

JC STC 2/5/2008 Technology ICT
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To create the buttons use the images provided in the images folder e.g. homebtn_1.png and
| homebtn_2.pgn. You will notice there are two images for each button, one image will be place
on your page and when you hover with the mouse over it, it will change to the second image
L and then when you click on it, it will navigate you to another page.

—— Select the cell you wish to insert your button in, then select the image rollover button from the
| top menu bar
N (COMMON)

B% Adobe Dreamweaver CS3 - [C:\Documents and Settings\user\DesktophJ
File Edit WView Insert Modify Text Commands Site Window Help

i wInsert Common Layout | Forms | Data | Spry | Text | Favorites

R E & FE B %Hﬁl B R L-- | B-F

image k| - image rollover

Browse and insert the buttons
you want and leave the link

Insert Rollover Image

empty at the moment. Click IR e
Otl:{ repea.t tr;.ls fobr itl',l the Original image: |images,l'homebtn_1.png |[ Browse, .. ]
| other navigation buttons.
:W‘Fr PR Rollover image: |images,|'homebtn_2.png ” Boeohs ] -_HB|P
'LJL E Preload rollover image
W ;‘,;/F, Alternate kext: | |
e
| | When clicked, Go ko URL: | |[ Browse. .. ]
)

" To browse to see how your buttons work save your work first then select the Preview
jT: button and select preview in browser @,
|

U\;v// - The Internet Explorer browser will open and will display your web page, hover your mouse

T
! ! = the outline of a table

— You need to think about the
layout and design of your

D . Ky website, here are some

; @) examples and on the next
page are thumbnails of the
pictures in the images folder

over your buttons and you will see the button change

Oscars

A dramatic moment

Sha Tin College News

Abig finish

TASK 7

pages will link to each other. You need to create a design on paper for the layout of your web-
- site. Itis important to think about how people will navigate from one page to the next.

.~ From your website, there will be three links from the home page which go to the following
pages:

e CAS

® The Concert

e The Oscars

T You are going to consider the planning of your website, how each page will look and how the
rf ==
I

You may decide that when you visit the Concert page for example, there may be three further
links to these pages:

® The Orchestra
® The Choir
® The Music

JC STC 2/5/2008 Technology ICT 1 1



These can be shown as a diagram known as a ‘Hierarchy Diagram’ (see below)

Home Page

The Concert The Oscars CAS

Orchestra Choir

Music

This diagram clearly shows that I will have three links coming from my home page and so on.
Task 8

Now it is time to think about what pages you will need and how you will navigate to them.

Design a Hierarchy Diagram for your own website. Choose appropriate software to create
your hierarchy diagram. (PowerPoint or Word) Print off a copy remembering to add your
name, class, date and Task 6 in the footer.

hamebtn_1.prg harmebtn_2.png cas3.jpg cass.jpg

oscard.jpg oscard.jpg

oscarbknl.png oscarbtnz.png

rockZ.jpg

Yeviews

v rockbtnl . prig rockbtn2.png sclogo, pnig kitle.pnig
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HOMEWORK TASK 4

—<W--
'#;?LT Website Planning Sheet
— Plan your web pages using the grid below, each square represents 40 pixels, mark out your

- o tables and where the images and buttons will go, don’t forget label the sizes of each image

&/ Y and each cell of your table.
—~--  You can copy more website planning pages from you Student Resources folder
LT ‘website planning sheet.doc’
7[ F- 800 pixels wide

Additional sheets at www.msc-ks3technology.wikispaces.com
13
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TASK 9

Open up Dreamweaver and return to your home page

To duplicate the page select the index.htm page from the Files menu on the RH of the

screen. Then right click on the page and a submenu appears, select Edit and then select
Duplicate. Select the newly copied page from the Files menu and select Edit and Rename
and give the new page a new name (don't forget to leave the .htm/ tag on the page)

To create the other pages with a similar layout and to have the buttons in exactly the same
place, it is easier to duplicate the index page, than redo each page from scratch!!

— Files [ N = oscars)pg LRSS JUICK LI,
ik Css (b ear s | |localview x| b e @ oscar3.jpg 30KE QuickTim,
i » Application e[z rae/® 0 ¢ - [%] oscarbinipng  35KB PNG Imag
ii » Tag Inspector Local Files [ size[type  [Modified W i i ,ﬂ oscarbtn2.png 35KE PMG Imac
— E 3 Site - Year 8 (C:\Doc... Folder 04022008 @31 | | i B rockling 88KE QuickTim.
i ¥ Files B Images Folder  04/02/2008 18:31 B ~ )
fil | SR index.himi A TR | rock2.jpg 38KB QuickTim.
s wewrle M B rocks.jpg 32KB QuickTim.
New Fold
£ vear 8 w | |Local view oizn e e [%] rockbtnipng 35KE PMNG Imag
i = 'S [ . [%] rockbinz.png I9KB PNG Imag
Local Files Size| Type cut ctr:+x‘ @ ...... sdlogo.png 83KB PNG Imag
ite - : c ctrl+c
= ED |te Year 8 (C:'\Doc... Folder e M P S 26KE PNG Imac
T N e YT Folder Deletz Dol P B [ ) indes. html 2B Firefox D
~ TN index. hitml 1KB Firefox D... R Y e bl T
. Rename
o )
SR

g J\ To link the pages together, on the index page select the second button and the info about the
button will appear in the properties menu

Next to the Link field there is a little clock, click and drag the arrow to the page you want to
link to in the Files menu

14 UKL Ly

JIMU PN Lnays

<body> <a>|<img#cas:| - [k & O [100% «|605x% 357+ 36K /6 sec rockbtn2.png 39KB PNG Image
i ¥ Properties sclogo.png B3KE PNG Imag:
title. png 26KB PMG Imange
Image, 35Ky (129 Src |Imagesfcasbinipng |63 Alt v
:% ges/ g S0 -] index. himl 2KE Firefox D.
cas H|129 Link: | cas.html o = " i T cas.html 2KB Firefox D,
Map V Space Target w Border |0 E £ £
|i| i D “\ﬂ H Space Low Src &y Align |Default v

Save your work and preview in the web browser

Continue to build up your pages for your website, you should complete 4 pages, the homepage,
CAS, The Concert and The Oscars. It is important that there is some consistency in the layout
and style of the pages.

TASK 10

To make your site more interesting, use some of the additional material in the folder of images
And add some of the following

e Adding a repeating background (Modify menu >Page Properties >Background image
>Repeat)

Additional images - in the additional images folders on the staff drive

Buttons using text and rollovers

Adding the date/time to your website

Links to other sites e.g. STC

Adding a link to an Email account

14
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TASK 11

7‘7‘ " 7 Peer evaluation

B s Using the table below open your website onto the computer, and ask four people to review it
E using PIM’s

N -

L Name Positive Interesting Minus

] F
sai -~ Self evaluation
P In the space below complete the simple self evaluation statements, (think about the PIM’s
evaluation) add a printout of each of your pages from your website, using printscreen, and show
the files and layout of at least one page in Dreamweaver

Have I planned and created pages for my website?

Have I added appropriate text and images to my web pages?
L [ Have I planned and created hyperlinks to navigate through my web pages?
Have a evaluated my pages to make sure they were suitable for a wide audience?

.~ Can describe the steps I have worked through to create my web pages and suggest how they
can be improved?

Task 12

Word Search Homework
Revision, look at your word search for the key words
Test

JC STC 2/5/2008 Technology ICT 1 5



HOMEWORK TASK

This task is to be completed for homework.

Find the words below in the word search and learn and understand their meaning and definitions

u T Y U | I E R A R C H Y A D F G H J K
Q NWER T Y H Y P E R L I N K U I O P A S
D F I N D E X G H J K I L Z X C V B N M QW
E R T F DY U I O P A T B R O A D B A N D S
D F G H O J K S L S Z E X A C V B T N M QW
E R T Y WWR UE I T O R P A N S D A F G T H
J W K L N Z M A X Y C I Vv B N D I G I T A L
M E Q W L E R R T L Y A U I O P W A S D B F
G B H J O K L €C E E zZz X W C V B N I M Q L W
F S E R A T Y H U S I O E P A S D F D S8 E G
I |l Mm O D E M E H H O J B O D Y T E X T K L
L T L z2z X €C V N B E N U B M Q W H E R R H T
E E Y E I O P G A E S DR F G H E J K U T L
s z X ¢C E vV B I N T M Q O CWE MR T C TY
/I R U I O X P N A S D F W G E H E J K T P L
Z O zZz X €C V T E B N M Q S W E L R T Y U I O
E L P AU D I E N C E A E S8 D F O N T R D F
G L HJ K L Z X N C V B R N M QW C E E R T
H O M E P A G E Y S U I O P A S D F A G H J
K v L Zz X C V B N M I Q W E L A Y O U T R T
Yy E U I O P A §$ D F G OH J K L zZ X C V O B
NR M N A V I G A T I O NQWEW R T Y U I R
Web browser Bandwidth Website Tag
Uniform Resource Locator Search engine Navigation Rollover
Layout http Homepage Style sheet
Body text File extension Font File size
Download Hyperlink Modem Theme
Digital Index Broadband Audience
Hierarchy Table Criteria Structure

The file for the first page of a website must always be called ...... ?

The picture file-types you can use on a website are ...?

When you optimize a picture for a website you ...... ?

What should you use to help control the layout of a web-page?
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